Intro to Google Earth

Daniel M Russell, Google Search Quality and User Happiness

drussell+RAFT@google.com materials at: dmrussell.googlepages.com
RAFT Class, Oct 2, 2008

— In which we learn how to navigate around the world,
make new paths and plan lessons using Google Earth



mailto:drussell+RAFT@google.com

L evels of use

1. Basic: Browsing, flying around, virtual tourism

2. Middle: Organizing into lesson plans, shifting the nature of the
questions that can be asked (shift from “where” to “how” and “why”
questions)

3. Advanced: Creating new content to share with others; building new
layers or using the API to extend the capabilities of Earth



Course outline

Flying with Google Earth
-Examines the controls used to get around in Google Earth

Using Placemarks
- Looks at what a placemark is and how they can be used

GE Tips
- General tips on using Google Earth

Overlays
- Shows how to lay pictures over the ground in Google Earth
Creating Placemarks
- Shows the basics of creating placemarks which can be used in lessons
Images and the Web
- Shows how to use graphics from the web in placemarks
Network Links
- What a network link is and how it can be used
The Art of Map Making



http://e-learning.geodata.soton.ac.uk/moodle/mod/resource/view.php?id=349
http://e-learning.geodata.soton.ac.uk/moodle/mod/resource/view.php?id=350
http://media.libsyn.com/media/kokae/tips.mp4
http://e-learning.geodata.soton.ac.uk/moodle/mod/resource/view.php?id=336
http://e-learning.geodata.soton.ac.uk/moodle/mod/resource/view.php?id=291
http://e-learning.geodata.soton.ac.uk/moodle/mod/resource/view.php?id=338
http://e-learning.geodata.soton.ac.uk/moodle/mod/resource/view.php?id=363
http://e-learning.geodata.soton.ac.uk/moodle/mod/resource/view.php?id=372

Starting up

« Make sure all the menu items are the same (Tools and Views)
« Panels tour
- Keyboard shortcuts



Terminology

- Placemark: alocation w/ style information; a mark on the map
- Layer: an additional layer of information atop the maps (can turn on/off)
- Tour: animated fly-thru from placemark to placemark



Flying... demo + shortcuts
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Google Earth Quick Start User Guide

1. Search Panel- Use to find places and directions

2, Overview Map- Use for an additional perspective

3. Hide/Show sidebar- Click to conceal or display
side bar

4 Placemark- Click to add a placemark
5. Polygon- Click to add a polygon

6. Path- Click to add a path
7
8

Fly To | Find Businesses | Directio
5 s e Image Overlay- Click to add an image

Measure- Click to measure distance

&g, 37407228, 12207162 9. Email- Click to email view or image
hobes in afizons v O 10. Print- Click to print current view
L 11. Navigation Controls- Use to tilt, zoom and move

T8 3 Folde b et 12. Layers Panel- Use to display points of interests

= Prink R 13. Places Panel- Use to locate, save, and organize
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Creating a placemark

« Add>Placemark

— then edit the
properties of
the placemark

« Show how to
modify a place-
mark Once made Google Earth - Edit Placemark

Latitude: | 20°54'26.64°N

Longitude: | 156°41"15.28"W

Description | Style, Color | View | Atitude |

De=cription:

Great place for longboard zurfing. ..




Adding Placemark into Folders

= Google Farth - New

21X

Maime: I.ﬂ.nimals af the Wiorld

v Allow this folder to be expanded
[T Show contents as options (radio button selection)

Dezcription I"-.-"iE-"-."'.-' |

Cescription:

Thi= folder contains all links ta a iy by tour of
animals from around the wworld, Join us as we
travel to each continent.

CIH,

Cancel

1. You can put placemarks into
folders...

To create a Folder (Ctrl+Shift+N)

This helps keep placemarks
organized.



Adding Placemarks

™ Google Earth - New

2. Add Placemark
(Ctrl+Shift+P)

To change the placemarkicon,
click the icon to the right of the
placemark name.

Mame: I.ﬂ.frican Animals

Latitucde: I 11°46'46 52" M

Longitude:; I 9°51'26 90"E

Crescription ISt-er,Cu:ulur |'v'iew |Mt'rtude |

i 21x]
Colar: I:‘ Scale: |1 0 i’ Cpacity: I1DD%§|

hitp: maps google comimapfileskmlipaldicon29. prg

Description:

go deep inta the East African savannah and jungles to
zee croociles, elephants, buffaloes, hippos, and gorillas.
Click on the link belows to see a movie.

Welcome to Africal Home of many exatic animals. Let's <:
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RLDEBD S,

| »

Add Custom lcon... | Clear Custom lcons | Mo lcon | O I Cancel |
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Adding Placemarks

open Link:

Open Link in Mew Window
Save Targek As, .,

Prink Target

Wo
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O

Show Picture

Save Picture As. ..
E-rnail Pickure. ..

Prink Pickure...

a0 Eo My Pictures

Set as Background
Set as Deskiop Item...

0Ol
0l
0

Zk

Copy

Copy Shorkcut
Paste

<

0}

#dd ko Favarites. ..

0} || Google Search

0l
O

Send To »
Page Info k

3. Adding Sounds or Video
Find media online (NOTE: media MUST be online....

—>
>

]

Length:

Bit rate:

Properties

Ol=

COsC AT LT 2]

Media bvpe:

Video codec;

Location:

Linkable.. Not on your desktop!)

Right Click on download icon and copy short cut

location
Paste in Placemark description

>

244 Kbps
Yideo

320 = 240
4:3

Windows Media sudio 2 Voice
20 kbps, 22 kHz, mono

Windows Media Yideo Ya

- OR as it streams Right Click, then click properties, and copy

Description Iame,cmnr Iwew IArt'rtude I

Description:

elcome to Africal Home of many exotic animals. Let's
oo deep into the East African savannah and jungles to
zee crocociles, elephants, buffaloes, hippoz, and garillaz.
Click on the link below to see & movie.

ittg: Sy unitedstreaming .comiclickDirector ctmiypefvide

hkkp: [ Unikedstreaming, com)videos 28756,

pOr28786_256k. asf




Image Overlays

To add an Image Overlay press
(Ctrl+Shift+0O) or from the
menu bar click “Add” then
“Image Overlay”

Rt Click on web image, then
click properties, and copy
address. (Note: make sure you
get all correlating lines of the
address)

Matne: IF'enguins

Adjust green box to desired
image size

Paste image address in the link
box

Link: |3r5-'.l"-.".-'eb.l'34DEI?’3F1 -Da2E-FFFC-B471544443431 AT jpg

Tranzparency:
Clear

Description |View |Att'rtude |Hefresh |L|:n:ati|:|n |

Descrigption:




Fly Over and Saving
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Line | Path |

Length;

Milez

[T Mousze Mavigstion

Certimeters
Meters
Kilometerz

S Inches

To find out distance traveled,
from the menu bar select
“Tools” then “Ruler”

By clicking different points with
your mouse you can create a
line or a path.

To convert units of measure
select from the drop down
menu.

Can also use polygon and circle
to measure



To look for businesses '

(i.e. Starbucks, Pizza
Parlors) in a particular

Find Businesses

Fly To ‘ Find Buzineszes h | i

Whiat 2.0, Restaurants
starbucks, orlando florics j

i

Mhere e.g., sauguat, MY

Current wieswy

location, type in the

name of the company,
city or zip code and
enter.

You will be able to find
reviews, addresses,
phone numbers, and
even get directions.

et —
[B) starbucks ﬂ

g 20 M Summetlin Ave, Orlanca

FL 32801

Starbucks

2453 5 Orange Ave, Orlando

FL 32806

M (@) starbucks

o 7600 Dr Philips Blvd, Orlanda

i FLaomg

- - (B Starbucks Cotte Company

= 13851 Towne Place Blvd,
Orlando, FL 32837

i starbucks

2573 S Kirkman Rd, Orlanda,

32611 |l

2o

o mn#. .

!.J,-:.l'

?,."J' Starbuzhs |

Starbuck%.—
ik by |

Starbucks
WD reviews

2573 5 Kirkman Rd
Orlanda, FL 32811

(407) §22-0952
starbucks.com - 13 more 5

Directions: To here - Fram here
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Stai bu cks




Layers: 3D Bwldmgs Google

Earth

. To turn on 3D buildings, go
down to the “Layers” menu and
check “3D Buildings”

. For added fun, zoom in, tilt
your screen and fly through the
streets

View: I Care

E] [=] @ Pritnary Database
L] B3 Terrain

HE;'&‘ GFeagraphic Weh
i D ﬁ’ Featured Content
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i_II_I n | PSR -



Layers: Earthquakes

‘ In the “Layer” menu under

)

“Geographic Features” is a
check box for “Earthquakes”

When you enable this icon,
images will be displayed of the
locations of a variety of
earthquakes. Click on the icon
to see date, magnitude, and a
weblink.

To view several earthquakes
along a fault line type in “Area
51”in the fly to box.

@r

Drate: 193261 6
Magnitude: 4.23993939399393952236

j

EERE N Rl

[ 1;—_' Shopping and Services
L] rr';!}- Tranzportation

[=] # Geographic Features
O ,‘, Yolcanoes

D @ Mourtains

D E USA Festures

D B wwizter Bodies

: . [v] @ Earthguakes

# L] 8 Travel and Tourizm




Creating a tour

- Add>Folder
(in MyPlaces)
You can drag your
placemarks in here

¥ Places

.| @ San Francizco historical imagery

= D-i Hiztorical San Francizco
= ()5 San Francisco historical imagery

Fhe around San Fra
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Copy
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Delete Contents Polygon
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Photo
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i Email...
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Great place for longboard =urfing...

Then click play!




Playing a tour (auto fly from place-to-place)

. Select a folder with placemarks (the tour), and click the Play icon, or
— Tools>Play Tour

[ Russel Yellowstone Trip 2008
e Temporary Places

= Google Earth Pro

File Edit View o=l Add  Help 3
¥ Search Web ; j > - ]
FlyT | FindBusi  ruler

Table

Fly to e.g., 1600 Pe GPS

@ Movie Maker

[»][+] Jackson, ¥
|:| [+ San Franc
[]Did you mean: Options...

Enter Flight Simulator... Ciri=Al+4A




Turning that tour into a movie

« (Onlyin Pro version)
— Tools>MovieMaker

« Note:

— Once you start recording,
you need to start the

tour playback immediately.

Recording STARTS when
you click “Record”

", -
= Movie Maker

Movie Type
Supperted Compres=ion Formats

Mowvie Quality Re=olution
{3_} Standard (Real-time control} FPS

|320x240 v
) High Quality (Tour-mode onky) 0w

Configure Movie Name

Save Az

(No File Specified)

[] Advanced

Record

Browse




Adding a photo overlay

- See World Near-Real Time Overlay
— Terrain following, clamped at altitude 0

— This near-realtime cloud image layer is available from:
http://bbs.keyhole.com/ubb/download.php?Number=373671




Lesson resources

« http://www.google.co.uk/schools/primary.html --
* Animal habitats

* Settlements

* Climate change

* Visual Arts

* Exploring your area

* Development

* The Romans in Britain

* Chocolate and fair trade

- http://www.google.com/educators/p earth.html
* More general discussion—samples of classroom uses (by grade)



http://www.google.co.uk/schools/primary.html
http://www.google.com/educators/p_earth.html

Other content

- Lewis & Clark expedition:
— http://www.gearthblog.com/blog/archives/2005/11/lewis and clark.html

« Juicy Geography
— British blog that points readers to tweaks, mods, and lesson plan ideas

« Must see collection of maps:
http://strangemaps.wordpress.com/


http://www.gearthblog.com/blog/archives/2005/11/lewis_and_clark.html

Linking Books to Earth

« http://google-latlong.blogspot.com/2007/08/goodle-book-search-in-google-earth.html

— Places mentioned in books can now be found using G-Earth

- Foragreat use of this in the classroom, see Google Lit Trips:

www.GoogleLitTrips.com — tours of books you might use in the classroom have
already been made (K-5, 6-8, 9-12, Higher Ed)



http://google-latlong.blogspot.com/2007/08/google-book-search-in-google-earth.html
http://www.googlelittrips.com/

- Google Sky is the same as Google Earth, with astronomical data rather
than earth planetary data. You can make placemarks, tours, layers, etc.




Integration with Sketchup Models

« Show Notre Dame:

— This is a model built in SketchUp (the 3D modeling system), then geo-
positioned in Paris correctly.




Projects to look at

Earth.google.com/outreach/showcase.html
-- compendium of examples; ideas you can use in your classroom



Advanced Topics

- Spreadsheet Mapper Tool
— Lets you import tables of data into G-Earth
— http://earth.google.com/outreach/tutorial mapper.html

« Searching for more great content:
— Use: filetype:KMZ (to find more content)

— Example: [ California missions filetype:KMZ ]

Note: A KMZ file is just a compressed form of a KML file. They both contain the same
information—the KMZ file is just smaller than the KML.

- Create your own SketchUp content and use for teaching purposes


http://earth.google.com/outreach/tutorial_mapper.html

What next?

- Anon-demand tool like Google Earth can change the way learning
happens...

— Where are the pyramids? WHY are they there?
— WHY is Cairo where it is?

— Where is the San Joaquin watershed?
— WHY does this affect salmon spawning?

— Where is the path of the California missionaries?

— WHY did they follow that path?
- Pet peeve: Were there other missions than those in Alta California?



Scavenger hunt

1) Name the famous monument at Lat 27°10'30.24"N Long 78° 2'32.14"E.

2) What is the measurement of one side of the pyramids in meters?

3) What is the distance between London and New York State in km?

4) What is the only WWF mission in Finland?

5) How far are you from home right now in km?

6) What is the name of the interesting rock formation found at 50.011,-110.113

7) Who is the person on the left in the picture in the top right corner of the Taj Mahal platform?

8) How big is a typical tank used to store oil or gas? (Look in LA for tank farms; measure one.)



Community

Current Events (11 viewing) [2] Education
FlacemarksOverlays regarding events of the day Students (7 viewing)
@ Fun and Games (14 viewing) Discussion area for students using Gaoodgle Eatth
Afun place to post mystery placemarks, pose riddles, and offer Educators
hints Discussion area for educators using Google Earth
@ Travel Information (64 viewing) @ Tools (3 viewing)
Advice from and for those who travel--hotels, restaurants, and Tools for using Google Earth in an educational setting:

placemarks, guides, tests, and other resources.

ather warldly wisdom

Transportation (52 viewing)
Flanes, Trains, Automobiles, Boats and wakes

@ Military (52 viewing)
All things military: hases, places, and events

@ People and Cultures (29 viewing)
Famous and infamous people, haoth real and imadgined, singly and
inQroups

@ Nature and Geography (54 vigwing)
matural locations and events of note and impart

History lllustrated (30 viewing)
Significant ewvents and places in history. Sure, you knowe what
happened, but do you know where it happened?

@ Huge and Unigue (13 viewing)
Large and unusual places: from China's Great Wall and the
higgest ball of twine to the Jello and peace capitals of the warld

For extra help, support, and unique and interesting
places, visit the Google Earth Community under the
“Help” menu.



References

http://earth.google.com/userguide/ -- Google’s official guide to Earth

http://google-latlong.blogspot.com/ -- Google Earth + Maps blog about
new features, ideas, data resources, case studies, etc.

How to get a free copy of Google Earth Pro (assuming you're an educator):

* Send a msg to GEEC@google.com -- You will be sent a qualifying
qguestionnaire. You fill out the form with info (name, title, school ID #,

etc.)



http://earth.google.com/userguide/
http://google-latlong.blogspot.com/
mailto:GEEC@google.com
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